QCAD

An Introduction to Computer-Aided Design (CAD)

Andrew Mustun
# Table of Contents

## Part I: Introduction 7

**Introduction** 8
- Target Audience 8
- Structure of 9
- How to use this Book 10
- Prerequisites 10
- From Manual Drafting to CAD 11

## Part II: First Steps with QCAD 15

**Introducing the QCAD Application** 16
- The First Start 16
- The Application Window 16

**Using CAD Tools** 19
- The CAD Toolbar 19
- Starting Tools 20
- Correcting Mistakes 21
- The Neutral State of QCAD 21
- Hands-on: Drawing a Rectangle 22
- Hands-on: A Line through the Middle 24
- Hands-on: Printing a Drawing 25
- Closing QCAD 26

## Part III: Basic CAD Concepts 27

**Viewing** 28
- The Viewing Tools 28
- Hands-on: Zooming in and out 28
- Hands-on: Panning 30
- Hands-on: Auto Zoom 31
- Hands-on: Window Zoom 31
- Notes 33
- Exercises 34

**Layers** 35
- What are Layers? 35
- Layers, Groups and Blocks 36
Part V: Blocks

Creating and Using Blocks
  What is a Block? 210
  The Block List 212
  Creating New Blocks 213
  Inserting Blocks 215
  Modifying Blocks 217
  Deleting Blocks 219
  Exploding Block References 220

Part VI: Import, Export and Printing

Import 222
  Bitmap Import 222
  SVG Import 224

Export 225
  Exporting Drawings 225
  Bitmap Export 225
  SVG Export 227
  PDF Export 228
  DXF Export 229

Printing 230
  Printing a Drawing 230
  Printing a Drawing to Scale 232

Part VII: Projections

Orthographic Projections 236
  Views of an Object 236
  Local Standards 237
  Drawing Techniques 239
  Hands-on: Orthographic Projections 242
  Exercises 253

Isometric Projections 255
  What are Isometric Projections? 255
  Creating Isometric Projections 256
  The Scale of Isometric Projections 260
Part II

First Steps with QCAD
Alternatively, you can also click the right button of your mouse to return back to the neutral state step by step. Depending how far you have progressed with a tool, you might have to click the right mouse button more than once to fully return to the neutral state. The same can also be achieved by hitting the Escape key on your keyboard a multiple times.

**Hands-on: Drawing a Rectangle**

The following instructions guide you through the complete procedure of drawing a simple rectangle. You will probably not yet understand all steps involved but it is crucial that you successfully complete these steps since all CAD tools work in a similar way like the rectangle tool.

![Figure 3-3: Choosing the CAD tools for drawing rectangles and activating the Snap to grid tool.](image)

1. Launch QCAD if it is not already running. QCAD shows its application window and creates a new, empty drawing.
2. Before you start drawing anything, save this empty drawing to a file on your disk. To do so, choose the menu **File - Save As...**
   The dialog for saving a drawing is shown. The dialog automatically suggests a location for your file. This location is usually not a bad place to start with. You might want to use a sub-folder `drawings` in this location instead, but to keep things simple the following steps assume that you use this default location for saving your drawing.
3. Type the filename `example` into the input field with the label `File name`, then click the **Save** button to save the empty drawing. The dialog window closes and you are now ready to start drawing.
   Although is is not necessary to first save the empty drawing, it is good practice to do so as it forces you to think about where you want to store the file before you start drawing.
4. Move your mouse cursor to the shape button as shown in Figure 3-3 at the left (1). Click the left mouse button to show the shape tools (2).
5. Click the button with a rectangle on it as shown in Figure 3-3 (2). QCAD now knows that you intend to draw a rectangle and shows the CAD toolbar with the snap tools.
6. Click the button with a grid on it as shown in Figure 3-3 (3).
7. Move the mouse cursor around in the drawing area. There are two things to notice:
   - The mouse cursor has changed its shape and is now shown as a pair of cross hairs.
   - There is a small yellow circle that follows the mouse cursor around whenever you move it. This circle is not positioned exactly under the mouse cursor. It ‘snaps’ always to the grid point in the drawing area that is the closest to the mouse cursor.
   This yellow circle indicates what position QCAD is currently working with. The exact position of the crosshair mouse cursor is irrelevant to QCAD as long as the
yellow circle is in the correct place. In the previous step you have chosen to use the grid for positioning (Snap to grid). QCAD is now automatically restricting the options for choosing a position to the grid points.

8. Click somewhere into the drawing area. A little red circle with a cross appears at the closest grid point as shown here:

You have now set the first corner of the rectangle you are about to draw. If you move the mouse cursor around in the drawing area, you will see that QCAD draws a rectangle from the chosen position to the grid point that is closest to the mouse cursor as shown below:

Note that this rectangle is not yet part of your drawing and keeps changing whenever you move the mouse. This is called a preview. QCAD uses these previews to show you what would be drawn if you would click the mouse button at this point.

9. Move the mouse cursor until the rectangle that is shown is three grid spacings wide and two grid spacings high. Your rectangle should look like that one in the figure above.

10. Click the left mouse button to set the second corner of the rectangle. This leaves you with a drawing that looks like this:

The rectangle that is shown now, is a part of your drawing.

11. QCAD is ready to draw the next rectangle and waits for the first corner of the next rectangle. Since we don't want to draw more rectangles, we will terminate this tool now. To do so, click the right mouse button twice. If you don't have a right mouse button, press the Escape or Esc key on your keyboard twice. The mouse cursor is back to normal and the CAD toolbar shows the same tools as it did after starting QCAD.
rectangle should still be visible. If that is not the case, you did something wrong and you need to carefully repeat the steps 4 to 10.

12. Save your drawing by choosing the menu File - Save.

In the example you have just completed, you have used a tool called Snap to grid. As a result, the corners of the rectangle are exactly aligned to the grid points. Snap tools are a central concept of any CAD system and there are many other snap tools you will get to know later in this book.

### Hands-on: A Line through the Middle

To emphasize the importance of snap tools, we will now extend our drawing with a vertical line that separates the rectangle in two equal halves.

*Vertical* means that the line extends from a first point to another point directly under or above it. In our case, the line starts in the middle of the top line of the rectangle and ends in the middle of the bottom line. The top and bottom lines of the rectangle are *horizontal*, that means they extend from left to right. You can easily remember what *horizontal* means by thinking that the horizon at the seaside looks *horizontal*.

Note that there are no grid dots at the center of the top and the bottom line of the rectangle. For this line we will have to use a different snap tool.

1. Choose the *Line Tools* button again from the CAD toolbar as shown in Figure 3-4 (1).
2. This time, select the tool *Line from 2 Points* (2).
3. Click the button *Middle* (3). This activates the snap tool to snap to middle points of lines and arcs. Note that only one snap tool can be active at any time.
4. Move the mouse cursor around in the drawing area like we did before with the grid snap tool. As you can see, the yellow circle no longer jumps from grid point to grid point. Instead it now only shows up in four different positions which are the middle points of the four lines that form the rectangle. One such possibility is shown here:
Chapter 8

Coordinates

Objective

In this chapter, you will

- learn what coordinates are,
- get to know the different types of coordinates QCAD supports,
- learn how to define positions by entering coordinates.

The Cartesian Coordinate System

In the previous chapters you have already seen and used the drawing area of QCAD. Like a sheet of paper, the drawing area is a flat area onto which you can draw something.

When working with a CAD system, you will often be confronted with the coordinate system of the drawing area. A coordinate system uniquely defines each point in the drawing area and in your drawing. If you point with a pen to any position in the drawing area, that position has a unique coordinate that defines where this point is in the drawing.

By far the most commonly used coordinate system is the Cartesian coordinate system. A coordinate system is not something that is given by nature. Coordinate systems were defined once by someone (in this case René Descartes in 1637) to define a standard for specifying the position of a point on a two dimensional surface. The Cartesian coordinate system is not only used in CAD applications but in many areas of mathematics, physics and engineering.

The Cartesian coordinate system is based on two axes that are at right angles (orthogonal) to each other. The horizontal axis is commonly called the X-axis while the vertical one is called the Y-axis as shown in Figure 8-1.
Figure 8-1: The coordinate axes of the Cartesian coordinate system.

The origin of the coordinate system is the point where the X and the Y axes cross each other. This point is also referred to as the absolute zero point or just absolute zero.

Both axes have a direction. The X-axis is directed to the right and the Y-axis upwards. This is not necessarily a logical choice, it was simply defined this way. As you can see in Figure 8-1, the axes are divided into smaller sections, each one unit long.

Any particular position can be described by its distance from the origin in X-direction and in Y-direction. For example the position of the point \( P \) in Figure 8-2 is 3 units away from the origin in X-direction and 2 units away from the origin in Y-direction. Or, to use the correct notation, the point \( P \) is located at \((3,2)\). This notation in brackets indicates the location of a point as a pair of an X-distance and a Y-distance \((X,Y)\).

Figure 8-2: The location of the point \( P \) can be noted as \((3,2)\) where 3 is the distance to the origin in X-direction and 2 is the distance to the origin in Y-direction.

If a point is located left of the origin, its X-coordinate turns negative. If it is located below the origin, its Y-coordinate turns negative. Figure 8-3 shows some points in the Cartesian coordinate system and their \((X,Y)\) notation. The \((X,Y)\) notation for the origin is \((0,0)\).
Preparations before Drawing

Before you draw anything you should set up the layers of your drawing as described in a previous chapter. The drawing tools of QCAD always draw all objects on the layer that is currently active. After creating a new empty drawing, spend some time to think about the layers you will be using for your drawing and create them. Whenever you are about to draw something, have a look at the layer list at the right to make sure that you are on the correct layer. It can be helpful to assign different colors to different layers, so you immediately realize that something is wrong if you draw on the wrong layer.

Line Tools

**Menu:** Draw > Line  
**Keycode:** WL

QCAD offers a variety of tools for drawing lines. They are all available in the CAD toolbar of QCAD after clicking the line button shown in Figure shows the CAD toolbar with the various tools for drawing lines. Note that you can click the button at the top with the left arrow to return to the main menu.

![Figure 9-2: The CAD toolbar showing the drawing tools for drawing lines.](image)

**Line from two Points**

**Menu:** Draw > Line > Line from 2 Points  
**Keycode:** LI

With this tool you can draw a single line by directly defining its start point and end point. It is also possible to draw a series of connected lines.
Drawing Tools

Chapter 9

Drawing a single line

1. Click the start point of the line.
2. Click the end point of the line.
3. Terminate the tool by clicking the right mouse button twice or by pressing the Escape key on your keyboard twice.

![Figure 9-3: Example for drawing a single line with startpoint and endpoint.](image)

Drawing a series of connected lines

1. Click the start point of the first line.
2. Click the end point of the first / next line. Repeat this until you have drawn all connected lines you want to draw.
3. Terminate the tool by clicking the right mouse button twice or by hitting the Escape key on your keyboard twice.

![Figure 9-4: Example for drawing a series of connected lines.](image)

Drawing a series of disconnected lines

1. Click the start point of the first / next line.
2. Click the end point of the first / next line.
3. Click the right mouse button once or hit the Escape key on your keyboard once.
4. Repeat steps 1-3 until you are finished with drawing lines.
5. Terminate the tool by clicking the right mouse button twice or by hitting the Escape key on your keyboard twice.
Part IV

Drawing and Editing with QCAD

Figure 9-5: Example for drawing a series of disconnected lines.

**Line with fixed Angle**

**Menu:** Draw > Line > Line from Angle  
**Keycode:** LA

This tool lets you draw lines at a fixed angle. The length of the line can be specified and you can choose if you want to position the line by defining its start point, middle point or end point.

When you are using this tool, you will often find that the length of the line is irrelevant at first and can be better adjusted later using a trim tool.

**Usage**

1. Enter the angle of the line in the options toolbar. Type a length for the line and choose how you want to position it.
2. Click the position of the line. You can also repeat this to place more than one line with the same angle or change the angle in the options toolbar at any time.
3. Terminate the tool by clicking the right mouse button twice or by hitting the Escape key on your keyboard twice.

Table 9-1 shows three example uses of this tool.

<table>
<thead>
<tr>
<th>Table 9-1</th>
<th>Line with Fixed Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tool options</strong></td>
<td><strong>Click point and constructed line</strong></td>
</tr>
</tbody>
</table>
| Angle: 30  
Length: 20  
Snap Point: Start | |
| Angle: 45  
Length: 30  
Snap Point: Middle | |
| Angle: 60  
Length: 20  
Snap Point: End | |
Rounding Corners (Fillet)

This tool is used to round corners. It works very similarly to the chamfering tool.

**Usage**

1. Start the round tool.

2. Enter the radius of the rounding in the options toolbar. Make sure that the Trim check box is ticked if you want to automatically trim the corner lines to the rounding. For this example, we want to create a rounding with a radius of 4.5 units with trimming enabled:

3. Pick the first entity that forms the corner you want to round. In our example, we click the top line of the rectangle as the first line of the top right corner which we want to round:

4. Move the mouse cursor to the second line of the corner. QCAD shows a preview of the rounding you are about to create. At this point it is important to place the mouse cursor at the correct side of the line since there are two roundings possible. If you place the mouse cursor somewhat to the right of the vertical line, an alternative rounding is shown:

Move the mouse cursor somewhat to the left of the vertical line to show the rounding we want to create:

5. Click the left mouse button when the preview shows the correct rounding.
6. QCAD creates an arc that is tangential to the two chosen lines and trims the lines to the arc as shown here:

![Arc Tangential to Lines]

7. The other corners can be rounded in the same way:

![Rounded Corners]

### Dividing Entities

**Menu:** Modify > Divide  
**Keycode:** DI

This tool divides (or cuts) an entity at a given point. You can for example divide a line into two parts. The division point must be on the entity and is in most cases an intersection point with another entity.

Entities often have to be divided to change the line style in the middle of an entity or to form closed contours for hatching or solid fills.

In the example in Figure, the original shape of a mechanical part before bending is shown with a dash-dot-dot line in the view at the bottom.

![Original Shape](dash-dot-dot-line)

![Divided Line](dashed-line)

**Figure 10-14:** Lines often need to be divided to apply different layers or line styles to the two separate parts.

### Usage

1. Start the dividing tool:
# Index

## Symbols

45 degree line 251  
@ 60

## A

Absolute Cartesian coordinates 60  
Absolute polar coordinates 61  
Absolute zero point 58  
Accuracy 11  
  definition 45  
  vs. precision 45  
Add layer 39  
Add node 104  
Advanced modification tools 135  
Align 164  
Aligned dimension 185  
Angle  
  direction 61  
  measuring 174  
Angle between lines 174  
Angle dimension 193  
Append node 105  
Application window 16  
Arc  
  3 points 87  
  center, point, angles 85  
  concentric 88,89  
  offset 89  
  tangential 89  
  two points and angle 86  
  two points and radius 85  
Arc tools 84  
Architectural 184  
Architectural ticks 184  
Area  
  measuring 174  
Arrowheads 182,183  
Attributes 39,44  
Auto snap 245  
Auto zoom 31  
Automatic Zoom  
  after loading 28  
Automation 12  
Autosnap 48  
Auxiliary lines 13,245  
Axes 58

## B

B-Splines 98  
Bamboo 10  
Basic modification tools 125  
Bevel 154  
Bézier splines 98  
Bisector 76  
Bitmap Export 225  
Bitmaps 222  
Block  
  break up 220  
  change 217  
  creation 213  
  delete 219  
  edit 217  
  explode 220  
  inserting 215  
  list 212  
  modify 217  
  remove 219  
Block insert 210  
Block List 212  
Block reference 210  
Blocks 36,210  
BMP  
  export 225  
  import 222  
Boundary of a hatch 203  
Break out segment 158  
Break out Segment 243  
Break up 160  
Break up block reference 220  
Break up reference 220

## C

CAD  
  generic CAD 8  
  in general 8  
  vs. manual drafting 11  
CAD toolbar 19  
  drawing tools 72  
Cartesian coordinate system 58  
Cartesian coordinates 48,60  
Chair example 236  
Chamfer 154  
Change block 217  
Circle  
  3 points 94  
  center, point 91  
  center, radius 92  
  concentric 94,95  
  offset 95  
  two opposite points 93  
  two points and radius 92  
  with center, point 245  
Circle tools 90  
Circumference  
  measuring 174  
Clockwise 61  
Closed shape  
  selection of 122  
Closing QCAD 26  
Color 39  
Command line  
  hiding of 18  
Concentric 89,95  
Construction 72  
Construction lines 13
Index

Contour
   selection of 122
Control points 98
Coordinate entry 46
Coordinate system 58
   absolute Cartesian coordinates 60
   absolute polar coordinates 61
   absolute zero 58
   angle 61
   axes 58
   Cartesian coordinates 60
   negative coordinates 60
   origin 58
   polar coordinates 61,61
   relative Cartesian coordinates 60
   relative polar coordinates 61
   relative zero point 60,61
Coordinates 48,58
Copy 125,135
Copy and rotate 143
Correcting mistakes 21
Counter-clockwise 61
Creating Block 213
Creating drawing objects 72
Cut 125,157
Cut segment 158

d

Decimal 184
Degree
   of spline 98
Degrees 61
Delete 125
   polyline nodes 105
   polyline segments 106
Delete block 219
Delete small entities 163
Deselect
   area 121,121
   closed shape 122
   connected entities 122
   contour 122
   intersected 123
   layer 124
   polygon 121
   polygonal area 121
   rectangular area 121
   window 121
Deselect all 120
Deselect everything 120
Detect zero length entities 163
Diameter dimension 192
Diameter symbol 195
Dice example 238
Dimension
   aligned 185
   angle 193
   architectural 184
   architectural ticks 184
   arrowheads 183
   arrows 184
   custom text 194
   decimal 184
   diameter 192
   diameter symbol 195
   dimension line 182
   drawing of 184
   engineering 184
   extension lines 183
   fixed text label 195
   format 184
   fractional 184
   horizontal 188
   label 182
   leader 190
   linear 186
   moving reference points 199
   moving text label 198
   option toolbar 194
   ordinate 188
   precision 184
   preferences 183,184
   prefix 195
   radius 191
   symbols 196
   text 182,194
   tolerances 196
   tools 184
   vertical 188
Dimensions 181
   and precision 11
   arrowheads 182
   parts of 182
   text 182
Direction of angles 61
Distance
   measuring 173,173
Distance between points 173
Distance to entity 173
Divide 157
Divide 2 158
Draw
   arc 84
   circle 90
   dimension 181
   ellipse 96,96
   ellipse arc 97
   line 22,24,73
   polyline 102,103
   shape 109
   spline 98
Drawing
   area 58
   preparations 73
Drawing area 17
Drawing preferences
   dimension settings 183
Drawing scale 12,230
Drawing tools 72
Duplicate entities 163
DXF export 229
Index

E

Edit
bevel 154
break out segment 158,243
break up 160
bring to front 162
chamfer 154
copy 125,135
copy and rotate 143
cut 125,157
cut segment 158
delete 125
divide 157
divide 2 158
explode 160
fillet 156
flip 141
lengthen 151
mirror 141
move 133,135
move and rotate 143
move object grip 130
move object handle 130
move reference point 130
paste 125
polar duplicate 145
redo 21
remove 125
reset 21
rotate 138
rotate and counter-rotate 145
rounding 156
scale 140
send to back 162
split 160
stretching 152
text 161
translate 135
translate and rotate 143
trim 147
trim both 150
undo 21
Edit block 217
Editing
advanced 135
basic 125
Efficiency 13
Ellipse 96
Ellipse arc 97
Ellipse tools 96
Engineering 184
Equal parts 160
Equidistant polyline 107
Escape 22
Examples
chair 236
dice 238
Explode 160
Explode block reference 220
Explode reference 220
Export 225
Bitmaps 225
BMP 225
DXF 229
JPEG 225
PDF 228
PNG 225
SVG 227
Extend 147,151,243
Extension lines 183
File
dialog 22
open 28
PDF export 228
quit 26
save 22
save as 22
Fillet 156
First-angle projection 237
Fit points 98
Fit to page 230
Flip 141
Format of dimension text 184
Fractional 184
Freehand line 83
Front View 245
GIF
import 222
Graphics tablet 10
Grid 22
dots 17
Grips 130
of dimensions 199
Groups 36,210
GUI 17
application window 16
Handles 130
of dimensions 199
Hardware
mouse 10
requirements 10
screen 10
Hatch
tool 203
Hatches 202
boundary 203
creation of 203
Hide all layers 250
Horizontal dimension 188
Horizontal lines 251
Index

I
Images 222
Import
   bitmaps 222
Info 172
   angle 174
circumference 174
distance 173,173
   length 174
total length 174
Insert 210
Insert block 215
Introduction 8
Invert selection 121
ISO standard
   first-angle projection 237
Isometric projections 255

J
JPEG
   export 225
   import 222

K
Knots 98

L
Label of dimensions 182
Landscape 230
Layer
   add 39
   attributes 39,44
   color 39
   linetype 39
   name 39
   select 124
   width 39
Layer attributes 44
Layer list
   hiding of 18
Layer selection 124
Layers 35
   hide all 250
   preparing 73
   show all 251
Leader 190
Length
   measuring 174
Lengthen 151,243
Line
   45 degree 251
   auxiliary 13
   bisector 76
   freehand 83
   from two points 73
   horizontal 76,251
   offset 77,78
   orthogonal 81
   parallel 77,78
   point, tangent to circle 245
polygon 110,111
   rectangle 22
   relative angle 82
tangent 79,80
tools 22
   vertical 76
   with angle 75,251
   with two points 24
Line tools 73
Linear dimension 186
Linetype 39
Linetypes 38
Local standards 237

M
Mac OS X
   mouse 10
Manual drafting 11
Measuring
   angle 174
   area 174
circumference 174
distance 173,173
   length 174
total length 174
Measuring tools 172
Menu
   usage 18
Middle mouse button 30
Mirror 141
Mistakes
   correction of 21
Model
   scale 12
Modification 114
   CAD vs. manual drafting 11
   properties 166
Modification tools
   advanced 135
   basic 125
Modify 125,135
   align 164
   bevel 154
   break out segment 158,243
   break up 160
   bring to front 162
   chamfer 154
   copy 135
   copy and rotate 143
cut 157
   cut segment 158
   delete 125
Detect Duplicates 163
Detect Zero-Length Entities 163
divide 157
Index

divide 2 158
explode 160
extend 243
fillet 156
flip 141
lengthen 151,243
mirror 141
move 133,135
move and rotate 143
Offset 107
polar duplicate 145
remove 125
reverse 161
rotate 138
rotate and counter-rotate 145
round 245
rounding 156
scale 140
send to back 162
split 160
stretching 152
text 161
translate 135
translate and rotate 143
trim 147
trim both 150
Modify block 217
Mouse 10
   middle button 30
Mouse cursor 22
Mouse wheel 10,28
Move 133,135
Move and rotate 143

N

Negative coordinates 60
Neutral state 21
NURBS 98

O

Object grips 130
   of dimensions 199
Object handles 130
   of dimensions 199
Object snap 47
Offset 107
   arc 89
   circle 95
   line 77,78
Offset polyline 107
Oops 21
Open drawing 28
Ordinate dimension 188
Origin 58
Orthogonal 81
Orthographic projections 236
   drawing techniques 239

P

Pan zoom 30
Panning 30
Parallel 77,78
Paste 125
PDF export 228
Pen 10
Photographs 222
Planning 14
PNG
   export 225
   import 222
Polar coordinates 48,61,61
Polar duplicate 145
Polygon 110,111,112,112
   center, side 112
   side, side 112
Polyline
   add node 104
   append node 105
   delete node 105
   delete segments 106
   draw 103
   equidistant 107
   from segments 104
   offset 107
   trim segments 107
Polyline tools 102
Portrait 230
Precision 11,45
   angle entry 46
   coordinate entry 46
   definition 45
   distance entry 46
   factor entry 46
   snap tools 46
   techniques 46
   vs. accuracy 45
Prefix 195
Preparations
   before drawing 73
Prerequisites 10
Preview 22
Print preview 230
Printing 25,230
Projections
   first-angle projection 237
   isometric 255
   orthographic 236
   third-angle projection 237
Properties 166
Property editor 166
Proportional scaling 140

Q

QCAD
   application window 16
   download 10
getting QCAD 10
web site 10

R
Radius dimension 191
Raster files 222
Rectangle 22,109
Rectangle with Size 110
Red circle 60
Redo 21
Reference 210
Reference points 130
of dimensions 199
Relative Cartesian coordinates 48,60
Relative polar coordinates 48,61
Relative zero point 60,61
Remove block 219
Repetitive work 12
Requirements 10
Reset 21
Reverse 161
Right mouse button 22
Rotate 138
Rotate and counter-rotate 145
Rotational symmetry 12
Rounding 156,245

S
Save 22
Save as 22
Scale 140
of a drawing 12
printing 12
proportional 140
Scripting
automation with 12
Scroll bars 30
Select
area 121,121
closed shape 122
connected entities 122
contour 122
deselect all 120
deselect everything 120
intersected 123
invert selection 121
layer 124
polygon 121
polygonal area 121
rectangular area 121
select all 120
select everything 120
window 121
Select invert 121
Selection 114,116
advanced 119
in neutral state 116
Selection tools 116
Shape
polygon 112,112
polygon (center, side) 112
polygon (side, side) 112
rectangle 109
rectangle with size 110
Shape tools 109
Shorten 147,151
Show all layers 251
Side view 250
Snap
auto 48,245
center 48
center of selection 48
coordinate 48
distance 48
distance manual 48
delta 48
free 48
grid 22,48
intersection 48
intersection manual 48
middle 24,48
middle manual 48
on entity 48
orthogonal 48
perpendicular 48
polar coordinate 48
reference 48
selection center 48
tangential 48
Snap tools 24,46
Snap Tools 47
Solid Fills 202
Spline tools 98
Split into equal parts 160
Stretching 152
Styles 38
SVG
import 222
SVG Exports 227
Symbols 195

T
Tablet 10
Tangent 79,80,245
Target audience 8
Terminate tool 22
Text
edit 161
Text of dimensions 182
Texts 176
Third-angle projection 237
Ticks 184
TIFF
import 222
Tolerances 196
Toolbar
lines 22
Toolbars
CAD 19
Tools
Index

arcs 84
circles 90
eclipses 96
lines 73
modification 125,135
polylines 102
shapes 109
splines 98
Tool tips 19,20
Top view 243
Total length 174
Trim 147
  polyline segments 107
  when rounding corner 245
Trim Both 150
Trim Two 150

U
Undo 21
User interface
  drawing area 17
  menus 18

V
Vertical dimension 188
View
  auto zoom 31
  of an object 236
  pan zoom 30
  window zoom 31
  zoom in 28
  zoom out 28

W
Wacom 10
Width 39
Window
  application window 16
  Window zoom 31

X
X-axis 58

Y
Y-axis 58

Z
Zero point
  relative 60
Zoom factor 30
Zoom in 28